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What's inside

ubuntu®

14.04 LTS

Server
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Ubuntu 14.04.3 LTS Server 32bit
Private (NAT) & Local (Bridge) networks

Apache2 Web server & PHP5
Samba - windows network
OpenSSH

Webmin 1.780

Shellinabox

OpenGeo Suite 4.6.1

PostgreSQL 9.3.11 / PostGIS 2.1.4
GeoServer 2.6 (WCS, WMS, WFS, )
GeoWebCache

OpenLayers 2 & 3

Boundless SDK

GeoExplorer

natural earth sample

PostgreSQL 9.3.11

+

+
+
+

PostGIS 2.1.4

phpPgAdmin

postgis sample database
natural earth sample data

Passwords
LOGIN PASSWORD URL

Ubuntu shell (&sudo) gisvm gisvm http://gisvm:4200 (shellinabox)
GISVM internal site http://gisvm
OpenGeo dashboard gisvm gisvm http://gisvm/dashboard
GeoExplorer admin gisvm http://gisvm/geoexplorer
Geoserver http://gisvm/geoserver
PostgreSQL (postgis) postgres gisvm http://gisvm/phppgadmin/
Webmin gisvm gisvm http://gisvm:10000
Samba share (~/gisdata) (Windows Shortcut)
(/samba/gisdata) \\gisvm\gisdata
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First time run

Three simple steps: Download, unzip and run

1. Download

GIS Virtual Machine is a complete and independent computer on a file.

It is optimized to use less than 2 GB of space on your disk at start.

You can download and get it in a compacted 7z file that is less than 200 MB.

2. Unzip

After download it you must uncompress the 7z file.

You must have a uncompress program installed or install 7z available as free software:
http://www.7-zip.org/download.html

3. Run
To run it you must have a Virtual Machine Player installed or install a free available:

- Install VMware Player, available for free (recommended):
https://www.vmware.com/go/downloadplayer

%™ United States My VMware  Pariner Central  Training Community Store

Vmware@ Products  Cloud Services  Support  Downloads  Consulting Partn

Home = All Downloads > Viware Workstation Player

Download VMware Workstation Player

Minor Version:

Product Downloads Drivers & Tools. Open Source Need help downloading?

[ | About This Product
VMware Workstation 12.1.0 Player for l Download & | oL LN
DESCRIFTION

Windows 64-bit oberatina svstems. Ptiaraces Wincbochainn 191 1 Bissme

- Or install VirtualBox, available as free software:
https://www.virtualbox.org/wiki/Downloads

search. ..
ox Login  Preferences

Download VirtualBox

g Here, you will find links to VirtualBox binaries and its source code.
About

Screenshots ~ VirtualBox binaries

Downloads WOT—— pp— . -
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it
~J Run with VMware Player
- Start VMware Player and Player > File > Open... and select the “gisvm.vmx” file
found inside the gisvm unpacked folder.

E VMware Workstation 12 Player = O *

Player™ | [» ~ T ©

File > (3 New Virtual Machine Ctr+N |
e Open... Ctrl+O |
Removable Devices Download Virtual Appliance |
Send Ctrl+Alt+Del Preforances:: |

|3~ Connect to VMware Horizon FLEX Server Ctrl+E —
) Mo ’ _

- Then click on “Power on” or “Play virtual machine”

- s
E—E VMware Workstation 12 Player i '-'_'13 gisvm - VMware Workstation 12 Player
Player» | [ ~ S Player v hd l% E T l:_h

— am |
OWEr on
‘ @ Home L_I

buntu 14.04.3 LTS gisum ttyl

isum login: _

Or just double click the file “gisvm.vmx” found inside the gisvm unpacked folder.

NG

m‘ﬂ”'w

Run with VirtualBox

- Run VirtualBox and from menu: File> “Import Appliance...” select the “gisvm.ovf” file
found inside the gisvm unpacked folder.

- — . il
SRR P  Imparting Appliance ... Importing appliance ‘ChUse.. | 2
Machine Help @ Import Vi
& Preferences... Ctrl+G i Importing virtual disk image ‘gisvm.vmdk ... (2/3)
Appliancs
[ 8% X
| . — L
I ) Import Applisnce Ctrl+l o8 % e .
Export Appliance... Ctrl+E imported Vir
® P PP lelcome to VirtualBox! dicking on th
WVirtual Media Manager. Ctrl+D e left part of this window is a lis Description Configuration =
B8 Network Operations Manager... ik yod Salai deaked Virtual System 1
&) Checkfor Updates... order to create a new virtualm €8 Name gisvm 2
in tool bar located at the top o = v
B Reset All Warnings B Guest 05 Type 4 Ubuntu (32-bit)
U can press the F1key to getir @ cru 1
7 Eit Ctl+Q o virtualbox.org for the latest
& ram 512 MB
e

- After importing, that only takes a min, you can “Start” the gisvm virtual machine

< gisvm [Running] - Oracle VM ammlﬁ_

File  Machine View Input Devices Help

File Machine Help

{:} {‘E} : ;; ; Ubuntu 14.04.3 LTS gisum ttyl
New Settings Discard Siﬂm !

Milgisun login: _
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How to use it

1. Use GeoExplorer composer to edit and create Web Maps

Use your browser to open the existing Web Map #1:
http://gisvm/geoexplorer/composer/#maps/1
And login as admin with password = gisvm

& Geokxplorer x

l(-ai gisvm/gecexplorer/composer/#maps/1 a@ || Q Search ﬁ' B 35 A &
N A

&Y Geobxplorer | [ Map- (£ @ \dentify &8 = Weasure » gEd0 ~
Layers Stz ==z
- 8

4 Overlays

E ne_10m_populated_places_simple

[¥Ine_10m_rivers_lake_centerlines
/
v

[¥]ne_10m_admin_1_states_provinces_lines

[¥I ne_10m_urban_areas
[
[¥|ne_10m_admin_0_countries
0
4 Base Maps
) None
@ MapQuest OpenStreetiap

You can now edit the map settings, add new layers and also edit and create new data
inside each layer.

First let’'s change the urban areas layer style. Select the “ne_10m_urban_areas” layer (1)
and click up on manage styles icon (2) or right-click and select Edit Styles (2). Add a new
style (3), call it “urban_areas” (4), save (5), select “Untitled 1” (6) and edit (7).

e [m} *
@ GeoExplorer x \+

.

@ gisvm/geoexplorer/composer/#maps/1 P ®. ﬁ’ B 4+ @ [

# ban_zrezs ¥ ne_10m_urban_areas f38dbs4c

™ o o ——————————= » 10m_urban_areas
& GeoExplorer | Map~ (= Frint | (@ Identify ‘&GEDEXNW | Ma General 4 Layers e = =

. ne 2 230 StVIE
Les g 2 L=yers ¥ me_10m_urba MName: greas f
o- 0 —_— _ Choose style:  |urban_areas A
. ’ _— i urban_areas|
Abstract: =

4 Owerlays = T
[Ane_1fm_populated_places_simple 3 Choose style: 4" Defz @ A @R o Edit @D
4 S Rules 6
IZne Om_rivers_lake_centerlines Q Adﬂ] - Emove g
7 @ untitied 1 \
Rules

_ 7
_,-:. Cuplicate

Ene_1 _admin_1_states_provincey_ lines
1 @ Gray Polygon witl

Foom to ayer extent

%

|Zne_1

admin_0_qg
4 Base Maps

ONDne
(®MapGuest OpenStreetMap 2

&) Remove layer
; Froperties
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Click on the Fill color (1) and using the Color Picker select a color of your choice (2), remove
the Stroke line (3), Save the Style (4), close the Color Picker window (5) and return to the

Layers Toolbar (6).

= m| *
/ @ GeoExplorer x |\ +
@ gisvm/geoexplorer/composer/#maps/1 & || Q Procurar ﬁ B ¥ A | =
£ GeoExplorer | [F]Map= (= Fint | @ Identify &8 Query = Measure ~ [ 5 Edit -] & Logout. admin
Layers ¥ ne_10m_urban_zrezs ¥ Mew Rule g o{ol_el % oem = ::

Basic | Lzbels 1l Advanced ur ¥
Color Picker
Name: Symbal:

[AFin
Color: @
il

Opadity:

6 Styles
Choose style:

urban_areas

@ Add © Remove o7 Edit & Duplicate

Rules

B Untitled 1

© Add @ Remove 7 Edit i Duplicsts

gisvm/geoexplorer/composer/#

Now let's add a new Google Satellite Base Map layer. Click on the green cross icon (1) to
Add layers, select available data from (2) Google Layers option (3), double click on Google
Satellite (4), return to Layers (5) and deactivate “ne_10m_admin_0_countries (6) to view the

Satellite data on the map.

| @ GeoExplorer x | +

@ gisvm/geoexplorer/composer/#maps/1 Léwrs s 2 SR S A T i
Sj j : Google Layers M
& GecExplorer | Map = |.-u Print.| : Local GeoServer .
Title % O
= Countries of the World it

ne_10m_admin_0_count...

ne_10m_admin_1_states... giswi

i £k GeoExplorer | Map~ (= Fint | @ ldentify

£ § Google Temain TERRAIN

Query ‘[|='Measule - e Edit

ne_10m_populated_plac..

BE e EBEBE B

ne_10m_rivers_|ake_cent... isvm:ne -
rve_1Dm_r|ver5_Iake_aerwerlmes ne_10m_urban_areas pRr— Layers Ql&l 4 B[ oom
# States of the USA usastate @D~ @ |

m_1ﬂm_adn|n_1_states_prwmces_ll a T s L“ 4 Overlays
ne_1Dm_pD‘puIated_plane5_5imple
Layers ¥ Awaili ole Layers
m_fﬂm_mhm_ms : e
[ ] View available dita : . .
ne_1Dm_r|ver5_Iake_wmerI|nes
ne_10m_admin_0_countries /
n ne_1Dm_ad'nin_1 _states_provinces! lines
4 Base Maps
ONDHE ne_1Dm_urban_area5
@MapQuest OpenStreetiap

(C)MapQuest OpenStreetiap
(@)Google Satellite

gisvm/geoexplorer/composer/#
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Let us now edit a polygon from the urban areas layer. First activate the
“ne_10m_urban_areas” layer (1), click the Query menu icon (2), right-click on a table line (3)
to zoom to that feature. Now click the Edit menu icon (4) and select the Modify option, click

on the feature polygon (5) and on the pop-up window click “Edit” icon (6)

o] wessusg, { et <))

@ GeoExplorer x|+

2 c||Q o

& gisvm/geoexplorer/composer/Fmaps/1

ﬁ' GeoExplorer | Map~ (= F
Layers
90-9+/9
4 Owerlays
rbe_1Dm_pnpulated aces_simple

[ Measure - |;_° Eﬁv%

bt

ne_10m_urban_areas.1 |+ |4 |X|

Mame Value

scalerank 2

featurecia Urban area

12.581

area_sgkm

Quer\r by current map extent

Qu ery by attributes :
5
Match any ¥ of the following: 8
@ w w ‘g8
(@ sdd congition G
8
3 Urban area £8.168 o
gisvm/ gecexplorer/composer/# @ Cancel #8 Query [ L

You are now on the edit vertex mode, so you can use your mouse to mode existing vertex
(1), add new vertex by selecting and dragging middle vertex (2) or remove existing vertex by
placing your mouse over the vertex and pressing the Del key on your keyboard. After making
your changes, just press Save green icon (3).

— O X
J @ Geobxplarer x |\ +
\'i@ gisvm/geoexplorer/composer/#maps/1 &y ‘:3\ Procurar ﬁ E ‘ ’ﬁ‘ 9 E
£ GeoExplorer | [l Map» (= Frint | (@) Identify [gg Query|{~ Messure ~ [T Edit - #] Logout, sdmin
Layers SE4 tx ==l
0-0F9 . ’ S R N |
4 Overlays ne_10m_wrban_areas.1 - x| |

ne_10m_populated_places_simple

Name Value

scalerank 2

ne_10m_rivers_lake_centerlines
P

ne_10m_admin_1_states_provinces_lines

area_sgkm  12.581

ne_1 Om_urban_areas

]
[(re_10m_admin_o_countries ——— N
i - i [@ Save J Cancel
4 Base Maps — s
(Oinone ma Save
(C)MspQuest OpenStreethMap

(®)Google Satellite

Imagens 2016 NASA, TeraMetrics  Termos de Liilizagdo
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Finally let us export the final map. Click menu Map icon (1) and select export map. Select
the icons available and click “next” (2) , select the size of the map and click preview (3), and
you can now use the html code to include the map in your website (4).

@ GeoExplorer % | if» GeoServer Welcome x l +

@ gisvm//gecexplorer/composer/#maps/1 c Q. Pracurmr Ll = £ a @& —
* o6 Edit -
| Export map

e
Map Size Large ¥ Height 400 Width 600

Your map is ready to be published to the web! Simply copy the folk
the map in your website:

S,
<iframe style="border: none;" height="400" width="600" src=
| fogecexplorer fviewer (#maps/1”></iframe >

Choose tools to include in the toolbar:

E (S Frint Map

4[] Pan Map

@ Get Feature Info
& 1 measure

% []Zoom in / Zoom out
[ =[“]zoom Te Previous Extent / Zoom To Next Extent
; :Znom To Max Extent
I Show Legend
&[] Switch to 20 Viewsr

Preview

gisvm/gecexplorer/composer/#

If you include the html code in a simple html file, you will get the following web map page:

B c\Users\Ricardo\Deskta X | =+ = O b4

{ = > O | file:///C:/Users /Ricardo/Desktop/new.himl ‘;A.( | = @ @

@ BFEer-tx==188 @

I%l—l 1: 1091955
mi

Imagens 2016 TerraMetrica | Termos de Utilizegio
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2. Open QGIS sample project to view the included Natural Earth data

Use the QGIS installed on your computer or on any other computer at your network, to open
the included QGIS sample project file: “gisvm geoserver example.qgs” found in the qgis

subfolder inside the gisvm unpacked folder.
Note: If you don’t have QGIS installed, just download it from the official site and install it, it's

free software: http://www.qgis.org/

Ubuntu 14.04.3 LTS gisum ttyl

gisum login: _

7P Choose 13

Project Edit* View

- Organize - "Neﬁr'rﬁ:ll':['e'r' - '
a - :
0 Favorites = Nam& R
ﬂ w PR Desktop .;Z_q; ,-{ gisvim gecserver Ex,amhl.e ‘
4 Downloads . I

When you open the project all the data is store on the gisvm virtual machine, published by
geoserver using Web Map Services (WMS) of data stored inside the ° postgls database.

ntu 14.04.3 LTS gisvm ttyl

Layer Settings Pluging ‘Vector Raster Database Web Processing Help

BR[OS s0PLRARR

il =2 e iy aba by ah abc abg: abc ahe CoW
: i o ° % = il
g L 3 p
Layers (S

I}
Voo w93 @ G

sfb = I'_@ gisvm-ne-geoserver
g =- . ne_10m_populated_places simple
E]

ne_10m_rivers_lake_centerlines L
contexb.lal\"a'MSLegend 0&crs =EP5G: 4326 8dpiMode =7&featureCount=10&format =i |mage,|’|:|ng&layers ne lﬂmjopulatedjlaces smple&.

||| -/}5 : ne 10m_admin_0_countries l M m

it i

3. Add a new WMS layer to your QGIS project from Geoserver

To create a new WMS connection on QGIS, simply type: Name = geoserver-gisvm ;
URL = http://gisvm/geoserver/gisvm/wms

GISVM OPENGEO SUITE - QUICKSTART & PASSWORDS by Ricardo Pinho -

ricardo.pinho@gisvm.com
This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License



http://www.qgis.org/
mailto:ricardo.pinho@gisvm.com
http://creativecommons.org/licenses/by-sa/3.0/
http://creativecommons.org/licenses/by-sa/3.0/

After creating the connection just select it (geoserver-gisvm) and click on Connect to
dlsplay all WMS Iayers available to add to your project.

{ geoserver-gisvm % -

ew Edit Delete Load Save Add default servers

I Nama 2 Title | Abstract

GeoServer Web ... A compliant implementation of L‘
namral-earﬂﬂ 3’ Natural Earth GIS... Layer-Group type layer: natur.
S spearfish Layer-Group type layer: spear.
msmanl tasmania Layer-Group type layer: tasm

[ tiger-ny

e

tiger-ny Layer-Group type layer: tiger-ny
i

Image encoding
® PNG PNG8 JPEG TIFF SVG

Coordinate Reference System (58 54vawlab\e}

Tile size

Feature limit for GetFeatureInfo

WGS 84

Change...
Use contextual WMS Legend

% Layer name | Matural Earth GISVM

@ Close Help
- 1Layer(s) selected

% I

4. Create a new WMS layer with GSVM Geoserver and PostGIS

Add any layer to your QGIS project, for example, the roads shapefile (ne_10m_roads.zip)
from Natural Earth dataset: http://www.naturalearthdata.com/downloads/10m-cultural-vectors/

Source type

“lubuntu 14.04.3 LTS gisun ttyl ® Fie Directory Database Protocol
. o ‘l Encoding | System 2

Project Edit View Layer Sett gs Plugins b\ector
E E - ?-: ME-.
|j L Clir* M " ; Kj
B\ om g
2/ O

Layers

O = ¥ @@

Source

Datase! | C:\UsersiRicardo'\Desktopine_10m_roads.zip | Browse |

: “ Denver: ’New York Parls
=R |_[jﬂ gisvm-ne n Fr.ann:lsoo 3 Atlarlta - EESEN

® — ne 10m roads S iami Dﬂkﬂq:: [

Va
L
'[: ! x @ populated_places ME‘XIOO CIW
o

Lagos
Populated places - scalerank ... : BOgOtE jcaracas L3 A

& .
Nalrobl
- % * populated places - Capital ol LimaRig'de-Janeiro Kmh“;)h * by
o 3 annesbur
x ne_lﬂm_pnpulated_plac&_s!... Santiago’  Buenos Aires 3 g 2 :
- % ° ne_10m_populated_places_si... - L Cape T'.:“'w] Melbour
o 3 ne_10m_admin_1_states_provin... 4 . : -

Use the DB Manager tool, in the Database menu, to import a PostGIS vector layer to
GISVM
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L. QG

Project Edit  View Vector Raster Database

DEBROR USSP s EPLRARR @ - B-

Layer Settings Plugins Web Processing Help

4 = \/ @8 - = - o 2 aR - - - [
¥ v 8 oRix T > | @ G el ax e sw Gl &
) o -
Layers EE: Import vector layer 2 I_x._J
Vo |0 = 9 @ @ O
E Inou | ne_10m_roads & D
=-1%¢ @ g vm-ne
e x ne 10m roads Update options
'ﬂ E‘ x ﬂ populated_places
i : ! DB Manager :_ - Output table
t Sch =
R Jatabase Schema Table o S
1 Table | ne_10m_roads T
5 & 10
o EOE
Tree E Options
G E
% E‘ i P.ostGIS Primary key [1 ]
il gismes
@ i -} @ ne Geometry column E ]
: iyl ne_10m_admin_0_cound |
% -\ ne_10m_admin_1_states [oAhes S0 :j Target SRID :]
% ne_10m_populated_plag Encodin [
UTF-3 X
@ & ne 10m_rivers_lake_cend)| . | ]
; 3 ne_10m_urban_areas Drop existing table
: B @ _F‘Ub“c Create single-part geometries instead o1 . lti-part
[ 4 Spatialite Ve
¢ Create spatial index
s e
¥ |
| cordinate | | PostGIS ﬂ
:
P——-’—- Y

The ne_10m_roads layer (table) is now available to be used from PostGIS on GISVM. You
can publish it as a WMS layer with Geoserver and add it to your QGIS project, just like
before

To do that you must login in the geoserver web administration site: http://gisvm/geoserver ,
enter Login = admin , Password = gisvm , and select “Remember me” to avoid typing it
again in the future:

'@; GeoServer: Welcome 1 x ) :
2 @ || Q search . &8
GeoS erv;\/’ (=5 . (T8

Welcome

Welcome

0 3+ & O

" -
Remember 1=

About & Status
@ About GeoServer

Data
Layer Preview

This GeoServer belongs to The ancient geographes INC.

This GeoServer instance is running version 2.8.2. For more information please contact the

Demos

administrator.

Service Capabilities
WCs

1.0.0

11D
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5. Create a new WMS layer from PostGIS store

To add a new Layer, select the left Data > Layers menu and click on “Add a new
resource”

v GeoServer

About & Status

\f\ Server Status

=| GeoServer Logs
23 Contact Informatio |
@ About GeoSery,

o Results 1 to 5 (out of 5 matches from 24 items) -, gisvm
Layer Preylbw [[] Type Workspace Store Layer Name

I Warkspages B M gisvm postgis_ne ne_10m_rivers_lake_centerlines

Ny 1 B e gisvm postgis_ne ne_10m_populated_places_simple
: a\,fler i [ ¥ gisvm postgis_ne ne_10m_admin_1_states_provinces_lines
¥ Styles
] AJ gisvm postgis_ne ne_10m_admin_0_countries

Services

B wes [ u qgisvm postgis_ne ne_10m_urban_areas

& wrs = <] |2 - | Results 1 to 5 (out of 5 matches from 24 items)

B WMS

Select the existing “postgis_ne” resource, a postgis datasource created to access ne schema of
postgis database. And publish the new uploaded layer: ne_10m_roads by clicking on “Publish”

Logged in as admin. ﬂ_,l Lo

GeoServer

New Layer

AL G Add 3 new layer

|, Server Status

GeoServer Logs . . 1
" i

22 Contact Information = - .
z Add fayer frofln | gisvm:postgis_ne Elp
& About GeoServer ﬂ*—w i

You can create a geW TeatreeypE Y manually configuring the attribute names and types. Create new feature type...
Data 0On databases yoy 'can also create a new feature type by configuring a native SQL statement. Configure new SQL view...
Layer Preview Here is a list of résources contained in the store 'postgis_ne'. Click on the lyer you wish to configure
=2 Workspaces )
3 Stores << || < | 1§ > | =>|Results0 to 0 (out of 0 items) -, Search
1M Layers Published Layer name Action
Sl | ayer Groups
@@ Styles 4 ne_10m_admin_0_countries Publish again

4 ne_10m_admin_1_states_provinces_lines Publish again
Services = - — 24 = d
& wes "4 ne_10m_populated_places_simple Publish again
]_j WES 4 ne_10m rivers_lake centerlines Publish again
1§ wMs

4 ne_10m_urban_areas Publish again
Settings 2 .
3 ne_10m_roads — @
8 Global 5 : -
B2 A

I rrvarana drrace
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Use the default layer Name = ne_10m_roads , click “Compute from data” and “Compute
from native bounds” to calculate both Bounding Boxes limits, and then Save the layer.

Edit Layer

Edit lzyer data and publishing

gisvm:ne_10m_roads

Configure the rescurce and publishing information for the current layer
Data Publishing Dimensions Tile Caching

Basic Resource Info

Advertised

Title

ne_10m_roads
Abstract

Coordinate Reference Systems

MNative SRS

EPSG:4326 EPSG:WGS 84...
Declared SRS

EPSG:4326

SRS handling
Force dedared E|

EPSG:WGS 84...

Bounding Boxes
Native Bounding Box
Min X Min ¥ Max X Max ¥
A2¢ | -48.8327560424808 | 179.631500244141 | 71.5675048828125

Max X Max ¥
56(#4805 179.631500244141 | 71.567504B8828125

To Preview the just created layer, select the Data > Layer Preview menu and click on
“Open Layers” link on the “ne_10m_roads” line.

Logged in as admin. ﬁ_] Logout

GeoServer

Layer Preview

SICHER SR List of all lyers configured in GeoServer and provides previews in various formats for each.

F\. Server Status
GeoServer Logs

2% Contact Information < Results 1 to 7 (out of 7 matches from 29 items) -, gisvm
& About GeoServer T L Title n ts Al ]
1 1 gisvrm:ne_10m_rivers_lake_centerines ne_10m_rivers_lake_centerlines Openlayers KML GML | Select on
S*ores ) gisvm:ne_10m_populated_places_simple ne_10m_populated_places_simple Openlayers KML GML | Select on
W Layers R
@l Layer Groups “ gisvm:ne_10m_admin_1_states_provinces_lines ne_10m_admin_1_states_provinces_lines Openlayers KML GML | Select on
D styles
- | gisvm:ne_10m_admin_0_countries ne_10m_admin_0_countries Openlayers KML GML | Select on
Services
‘g :::Eé H gisvm:ne_10m_urban_areas ne_10m_urban_areas 2 Openlayers KML GML | Select on
i wMs
1 gisvm:ne_10m_roads ne_10m_roads L GML | Select on
Settings -
& Global i gisvm:naturak-earth Natural Earth GISVM Openlayers KML Select on
BT 1ar
= Coverage Access Results 1 to 7 (out of 7 matches from 29 items)
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It opens a new browser tab with a interactive webmap to navigate through ne_10m_roads

WMS, using open layers:

Openlayers map preview

Scale =1 : 140M
Click on the map to get feature info

You can now add it to your QGIS project. Use the “Add WMS/WMTS” layer button, select
geoserver-gisvm to Connect to geoserver WMS, click on ne_10m_roads and Add it to
your QGIS project. Click Close button to exit the Add layers windows.

E m

E@ @ A NG :{%
Layers

Edit Delete

Title | Abstract

“he_10m_admin_1... ne_10m_admin_1...
ney, 10m_populat...

ne 10m roads
18

ne_10m_populat...

3

ne_10m foa

4

Image encoding

® PNG PNGE

Tile size

WGS 84

Use contextual WMS Legend

Layer name ne_10m_roads

1Layer(s) selected

Coordinate Reference System (48

Feature limit for GetFeatureInfo |

GIF TIFF 5VG

54 gvailable)

10

Change...

| Close Help

€ EPSG:4326

ricardo.pinho@gisvm.com

=
rnder
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How to manage it

GISVM comes installed with two great full feature administration tools that you can use to
manage it completely: phpPgAdmin and Webmin

1. Using phpPgAdmin to manage the PostgreSQL server

To manage the PostgreSQL running inside the GISVM you can use the included web
application phpPgAdmin: http://gisvm/phppgadmin, login with postgres, password =
gisvm

[ m: ~/gise. % | TP phpPgadmin +
| (' L0 | gisvm/phppgadmin/ C || Q Search oA 9 » =
rm;p;P;gA:;dein; PheFshamin 21
I———— i
B Senme: &
i [ PostgreSaL Lcqin to PostgreSQL
|
Usemname .postg.res
i =
Password LL1ll]
I Login |
i
back to top.

4

After login just navigate through postgis database, ne schema and ne_10m_airports table.
It allows the execution of all kinds of PostgreSQL operations, like browse and edit the data,
add a new column or DROP (delete) the table.

@ phpPgAdmin

'é-\-“? gi.s\.rm_-'Phppc_lfclmin_-’ c Q Search | ﬁ’ :=| + i O =

- gy
phpPgAdml = Postgre SGL 9.5.0 running on localhost 5432 — You are logged in as user “postgres” SGQL | History | Find | Logout
@phpPgA:lmin: @ Pa»stgrESQL-: L_J pa'stgisj: @ns-: @ ne_13m_airpans-:
B Servers &
& [§ PostgreSQL | =) pd © i & @ & 53 B
Ell_J postgis Columns  |ndexes’ Constraints’ Triggers’  Rules’ Admin Info Frivileges’ Import Export
5.8 Schemas
= &é Column Type ::jt Default Constraints Actions
- &y ne
: Elﬁ Tables gid integer :L?LTL nextval{ne_10m_airports_gid_seq':regclass) &= Browse | Alter | Privileges|
G5 ne_10m_admin_0_c|z| scslersnk smallint Browse | Alter | Privilages|
[ G5 ne_10m_admin_1_s festurecls character varying(80) Browse | Alter | Privileges|
El ne 10m airpor‘[g type character varying(50) Browse | Alter | Privileges|

- [f Columns name f‘a:y':':tzﬂﬂa Browse ﬂ Frivileges|
- Indexes sbbrev  character varying(4) Browse M Privilages|
& b4 Constraints location  character varying{50) Browss | Alter | Privieges
[
&

.- W Triggers e fw?d;s.a; Browse | Alter | Privileges
-y Rules —

: : character wse = ivileges
e E e &% Admin | et aningi2sg) e | (o)
...... @ Info i e f‘ﬂ:‘d‘;ﬁﬂ Browse | Alter | Privileges
...... &_ Privileges i

& fmport natlscale  double precision Browse | Alter | Privileges
""" - geom geometry(Foint, 4326) Browse | Alter | Privileges|
...... B> Export
|
-3 ne_10m_popu|ated_ Browse | Select | Insert | Empty | Drop | Add column | Alter
I G- [E5) ne_10m_rivers_lake
@[ ne_10m_roads o | backto top
gisvm/phppgadmin/tables.php?action= confirm_drop8server=localhost:5432:allow8database= postgisischema=ne&itable=ne_10m_airports | ) +
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2. Using pgAdmin Il to manage the PostgreSQL server

If you have installed the pgAdmin Ill on your computer you can also use it to manage the
PostgreSQL server running on GISVM. If you don’t, you can install it for free from:
http://www.postgresal.org/ftp/pgadmin3/release/v1.22.0/

Run pgAdmin and create a new Server Registration with: Name: gisvm , Host: gisvm ,
Username: postgres , Password: gisvm

[
File Edit Plugins View Tools Help .
4 fi Server Registra X
E Properties g1 S5H Tonnel  Advanced ]
Mame |gm1 | :
Host |ﬂ |
Port [s432 |
Service | | ?
u Maintenance DB |E5t£5 ~ | :
- Username |Dostgres | L
Password |"0" | [

Store password  [+]

Colour [ |

Group | Servers i |

£

Help QK Cancel E

Retrieving |

Then use that connection to access the PostgreSQL server running in GISVM:

W poAdmin i — =] b o
: ; : ; Refresh
File Edit Plugins View Tools Help e
| p— Count — =
i & &N % o | &= D &
[ & "5 | ﬁ ‘w3 | - =
: ‘ == }‘ Mew Object > W &
| Delctc/rop | Properties | Statistis | Dependences | Dependents | |
Drop cascaded... Property Value -
Truncate “=IName ne_10m_airports
'-J"% Catalogs (2) 5 Truncate Cascaded =0 21476
Event Triggers (0 = ,
g L Rezet table statistics ~= Owner postgres
[ k% Extensions (2) =
7 . :=|Tablespace pa_default
I:J---@ Schemas (2) Search objects... =i
B9 ne ) o
..... % Collations {0) Scripts > type hd
----- Domains (0) View Data > < >
s FT5 Configurations I
5 ne
il FTs Dictionaries (0] kepor » [ e e —
FTS Parsers (0) Maintenance... rlabtesnesne i al rports =
FI"STfamplates @ Backup... -- DROF TRAELE ne.ne_l0m airports;
: Functions (0) i
S Restore...
% Sequences (7) CREATE TABLE ne.ne 10m airports
B[ Tables (7) Import... =N
[ ne_10m_admin = gid serial NOT NULL,
[ ne_10m_admin Properties... scalerank amallint,
| m featurecla character varying(20),
[ ne_10m_populated_places_simple type character varying(50),
[ ne_10m_rivers_lake_centerlines name character varying(200j),
[ ne_10m_roads abbrev character varying(4),
& ne_10m_urban_areas Taratian rharastar wavrine (G v
Tri, _E .-_A- !rT\ v £ >
Retrieving details on table ne_10m_airports... Done, postgis on postgres@gisvm: 5432 110 msec
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3. Using Webmin to manage the Ubuntu operating system

To manage the ubuntu operating system in GISVM just use the included web application
Webmin inside your browser: http://gisvm:10000
Login with: gisvm and password: gisvm

‘*‘f gisvrm: 10000

¢ || Q Search » =

Login to Webmin

You must enter a username and
password to login to the Webmin
senver on gisvm

Username gisym

I Password eeses

[T1 Remember login
permanently?

Login

After login you can completely manage the GISVM virtual machine, make updates, create
new users, restart running services, configure network, server applications like SAMBA:

[ . =
‘gisdat 4 phpPgAdmin ¢ | €4 Webmin1780 on gisvm (U, % | & -
(€ # @ gisvminoo € || Q search w8 + A O =
Login: gisvm Mishia oty Samba Windows File Sharing TR
Samba version 4.1.6-Ubuntu

1 Webmin
. Select all. | Invert selection. | Create a new file share. | Create a new printer share. | Create a new
v copy. | View all connections.
~ Servers Share Name Path Security

Apache Webserver [T] printers All Printers Printable to all known users

EDSLQ[TSQ;DTMDESQ e 21 print$ Mvarflib/samba/printers Read only to all known users

ead User Mai
Samba Wind File Shari [[] gisdata /sambalgisdata Read/write to everyone
amba Windows File Sharing

SSH Server Select all. | Invert selection. | Create a new file share. | Create a new printer share. | Create a new
ot copy. | View all connections.
P ers
I Networking Delete Selected Shares
| Hardware
I Cluster Global Configuration

1} Un-used Modules

Search: E

Unix Networking Windows Networking

% @

(3

Authentication

=

=

Windows to Unix
Printing

£ View Module's Logs
£ System Information
\ @ Refresh Modules

@ Logout '#;
Miscellaneous Options Winbind Options File Share Defaults Printer Share Defaults
AddTyp,
Alias
5 etH;

GISVM OPENGEO SUITE - QUICKSTART & PASSWORDS by Ricardo Pinho -
ricardo.pinho@gisvm.com
This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License



http://gisvm:10000/
mailto:ricardo.pinho@gisvm.com
http://creativecommons.org/licenses/by-sa/3.0/
http://creativecommons.org/licenses/by-sa/3.0/

4. Use the local site to get more information on using GISVM

GISVM comes with a simple internal site with more information and several other links to
help you start using it: http://gisvm

OrenGEo Sume
GISVM 14.04.3
OpenGeo Suite
2016.02.27

About GISVM OpenGeo e
Suite

Just another incredible idea by GISVM project
to bring you the power of Free GIS Server software. et

Included Tools:

This irtual Machéne is besed on Free Software, built on Ubuntu Server version 14.04.3 with a seleched

sat of free GI5 Server software to provide you & complete virtual GI5 server companion that you can run
wihien and where you need the power of free GIS server software. [t can be easily adapted to meet one's

personal neads, sllowing the user to add rew dets or applications.

This OpenGen Suite edition is 3 complete geospatial platfiorm for managing data and building maps
and applications across web browsers, desktops, and mobile devices from data that can be stored on 2
relational database server (PostgreS0L) with spadal support (PostiGES). It slso indudes several net
=anvices end configurations that ease the dats communicstion between the virtual machine and the
pivysical machine in such & wey that allows GISYM to function 25 3 simpie machine within your computer
nebworic

Included Tools

GI5VM comes installed with some great full administration tools thet you can use to compisteby manage
it OpenGeao Suite Dashboard, GeoExplarer, Geoserver, Sheall in 8 box, phpPgAdmin, Webmin and gisdats
Samba share.

CE—pn  OPenGeo Suite Dashboard

b b 8= hitp:fgisvmidashboard
B R EEF OpenGeo Suite internal site that ghves you scoessto
— all comporeanits and documentation (PastGIS,

GeoServer, GeoVebCache, Boundless S0 and
GeoExplorer). Try several Demo and get infernal
access to all documentation.

GeoExplorer composer
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REMEMBER, USE GISVM AT YOUR OWN RISK

THERE 1S NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW. THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

THIS INFORMATION IS BEING GIVEN TO YOU GRATUITOUSLY AND THERE IS NO
AGREEMENT OR UNDERSTANDING BETWEEN YOU AND THE GISVM PROJET OR ME
(RICARDO PINHO) REGARDING YOUR USE OR MODIFICATION OF THIS
INFORMATION BEYOND THE CREATIVE COMMONS ATTRIBUTION-SHAREALIKE 3.0
UNPORTED LICENSE (CC BY-SA)

Please visit the GISVM project site regularly
to get updates and help us make it better!

http://gisvm.com

Thank you for using it.
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